This paper presents a working hypothesis for the development of Architectural Acoustic Teaching Software. The concepts and rationale underlying the development are discussed first and followed by a presentation of current first phase two-dimensional work in progress. The paper includes mention of some of the strengths and weaknesses of this first phase work as well as our initial thoughts and intentions about desirable features for a full three-dimensional implementation.
research concepts

The impetus for this investigation is a desire for a more effective demonstration to student architects of the spatial and temporal distribution of sound in rooms than is currently achieved in the classroom. The need is (1) to be able to explain clearly how a sound behaves in simple room-like enclosures as a part of teaching about architectural acoustics and (2) to provide students with a related convenient means for exploring sound in their own designs. This paper presents some initial work on a path toward our ultimate goal along with some of the rationale which underlies the endeavor.

The proposed application should concentrate on displaying the direct wave and first reflected waves since these represent the aspects of the sound field which an architect affects most directly. The initial layout of a room affects where sources and listeners will be located and the course of the direct wave from one to the other. The enclosing surfaces of this room affect the course of the first reflected waves reaching listeners. Both layout and enclosure result from initial design and should be examined immediately with respect to acoustics (as should all other design considerations which may be appropriate to the intended use but which lie outside acoustics).

There is no need for this application to encompass the entire temporal evolution of sounds through reverberant decay; that can be left to the more elaborate professional programs. However, to reveal the acoustical effect of an enclosure, it may be necessary to consider as much as a third-order reflection such as may occur at a ceiling corner in reflecting the direct wave back in the direction of listeners. Generally, however, only low-order reflections will be needed to display the initial acoustical consequences of a room design with respect to layout and enclosure.

teaching aspects

An interactive and animated computer software program, developed with introductory pedagogy in mind, may be a most useful way to approach the problem. Such a program should produce a three-dimensional representation of an architectural space (input from a drawing file with which a student has already been working in a design studio) and should animate a realistic three-dimensional sound field evolving and propagating throughout that space. The student should then be able to examine the resulting acoustical conditions in space and time, and furthermore, to easily manipulate the architectural features to learn in what ways and to what extent the acoustical results can be altered within the scope of that initial architectural design. The teacher, of course, will be able to produce and manipulate selected simplified room enclosures to create particular acoustical situations appropriate to teaching purposes using the same type of computer drawing files.

Everyone who has tried to teach acoustics to architectural students has probably resorted to drawing two-dimensional wave fronts and ray diagrams on the blackboard. Perhaps even some simple homework problems have been assigned to be explored by ray tracing using the method of images. Most textbooks contain several such diagrams. Invariably, the architectural spaces are represented by a simple enclosure geometry; certainly nothing as elaborate as is often built and certainly nothing with geometry as elaborate as students are wont to produce in their own design projects.

Sometimes, ripple tanks or spark photographs have been used to explain the reflections of sound in two-dimensional slices of rooms. When carefully done, such visualizations are very effective and seem to reach students easily at an almost intuitive level. One can see the launching of a sound wave, watch it sweep out through the section, watch reflections develop at the boundary surfaces and sweep along
behind the direct wave; eventually the ripples die out. All of this happens in an apparently realistic manner. The problems are that specialized laboratory apparatus is required, significant operational skill is needed, the sections are inherently two-dimensional so that the three-dimensional reality has to be visualized by mental construction, and the two-dimensional sections were probably chosen with a’priori expert knowledge. There are also some technical reservations about these analog modeling techniques which merit discussion elsewhere.

Nevertheless, a wave front sweeping out through a model section, followed by early reflections sweeping along behind the direct wave, comes the closest to providing easy comprehension of spatial and temporal consequences among the visualization tools now available. If, somehow, a similar presentation can be generated on the computer in response to a convenient computer-aided preliminary architectural design process, it would seem to serve the needs of both acoustic pedagogy and preliminary design. It might even overcome a student’s natural reluctance to face acoustical considerations until a design concept has been finished when it is already too late in the thinking process to make many appropriate and acceptable alterations.

Another reason for opting for a computer program, is that computers are available now to most students and can be accessed whenever convenient. Special laboratory or demonstration instrumentation, even if fully adequate to the task, is not and can not be so readily accessible in the numbers and at the times most convenient for students. Also, such instrumentation probably could not readily interface with a sketch or drawing format which a student will already be using. Analogue models, even selected sections, require some skill and time to produce and probably cannot be easily modified to follow design changes. Thus, it seems timely to make an attempt in the direction of a computer software program.

Further considerations pointing in the direction of computers are the fact that computers are very effective at repetitive activities which human beings find tedious and the fact that the proposed program will operate within known laws of science. We are not trying to move into an unexplored realm of acoustical physics but only to deal with given situations in which the variable complexity of details tends to overwhelm students.

Three dimensional representation

The objectives expressed above present very difficult programming problems but even so it seems appropriate to begin to think in that direction. Architectural space and a sound field in that space are both inherently three-dimensional, so it is rational to insist on some method of three-dimensional representation. Studio instructors and technical instructors continually exhort students to try to think three-dimensionally so the desired acoustic program should start three dimensionally and then, as necessary, back down to selected two-dimensional representations. Sound fields in rooms also evolve in time, hence animation with a controllable rate seems essential.

It is not immediately clear what form the proposed three-dimensional representation should take. One might, for instance, imagine a sound impulse represented as an expanding spherical shell within a wire-frame representing the architectural space. As the expanding impulse begins to reflect back from the room surfaces, this representation will soon become too cluttered to comprehend in its entirety. However, if an initial 3D representation can guide the viewer to find where interesting acoustical consequences are occurring in space and time, then more readily comprehended local information (probably 20 sections, direction of arrival, time of arrival, sound intensity, etc.) can be called out for closer examination and interpretation in terms of what seems to be
desirable acoustically. The advantages would accrue by assigning the tedious repetitious drawing and display tasks to a computer so the user can concentrate on interpretation. The proposed program would not replace the need for acoustical learning and understanding but would help a student to arrive at a point of interpretation and design decision.

Two dimensional representation

Although the proposed application will eventually allow for the investigation and evaluation of full three-dimensional models of space and be able to display sound fields as 3D rays and wave fronts, the authors have learned from other geometric programming projects that first designing, implementing and testing a similar 2D application can be a valuable experience. In the test application, many of the features such as the dialog editors (see below), ray tracing algorithm, sound level calculation, and sound source and assembly library file formats can be easily translated for 3D use. Other features, such as the display of rays and waves must be redesigned completely. The simple file format for the enclosing walls must be abandoned in favor of a DXF import mechanism. Beyond the programming virtues of working out a similar 2D application first, it is the realization that a convenient 2D version may itself be a valuable teaching resource. Much of conventional teaching about architectural acoustics takes place now in a 2D mode and so a good 2D program could be very useful even though it does not directly further the goal of 3D understanding.

Sound represented as rays

A sound ray is itself an abstraction which more precisely represents optical than acoustical situations. Nevertheless, the professional acoustician is experienced at working with ray and/or image concepts and is usually quite skillful, from extensive prior experience, at selecting appropriate two-dimensional slices of architectural space to reveal or explain particular acoustical consequences. As space geometry becomes more complex than easily represented by simple straight line boundaries, the process of selecting appropriate sections and carrying out the corresponding ray-traces rapidly becomes more complex and time consuming. Even the imposition of an exposed gable ceiling or a barrel-vault ceiling over a rectangular floor plan leads to difficult skew ray-trace conditions. Also, a nagging concern remains about whether all of the important acoustical features have been revealed by the few slices chosen for explicit investigation by ray-tracing.

The problem for an architectural student is two-fold: learning enough about the ray/image abstraction in the short class-time available for real understanding of acoustics, and developing the drawing skill to efficiently apply the method in the midst of that student's design process. Students are seldom satisfied to design simple geometric spaces which can be readily analyzed and the drudgery of constructing meaningful analysis diagrams is completely at odds with their design thought processes. In short, ray tracing as a means for visualizing room acoustics, will be carried out in an acoustics class at the instructor's insistence but likely will be ignored outside of that class. The technique is seldom applied at the early design stages by a student (or the practicing architect, for that matter) when it could usefully inform a design; it is just too clumsy, complicated and distracting. The method may be utilized by a professional consultant at a much later stage in a real project but then it is only of indirect value to a learning process.

The generation of a fan of rays from a single point source is a simple programming task, as is the reflection of rays as they hit the enclosing surfaces. As the fan of rays in Figure 1 shows, an anomaly exists when rays reflect off the adjacent walls at a corner. The current implementation is strictly geometric; that is, the angle of
incidence of an incoming rays is equal to the angle of reflection of an outgoing wave. This may be a satisfactory representation for rays representing very high frequency sound, but for lower frequencies, the rays must somehow bend or diffract around corners. In the situation depicted in Figure 1, the gap created after reflection is not really devoid of sound but rather filled in with somewhat weaker diffracted sound by an amount which depends upon the wavelength of the sound. In other words, a simple ray-trace approach tends to be somewhat too dramatic and harsh in what it portrays.

sound represented by wave fronts

It was determined early in the project that directly generating, storing and displaying sound fields as wave fronts (as in spark photographs) would be a difficult task. Original wave fronts before reflection are simple arcs or continuous full circles, but after hitting reflecting walls they become fragmented and difficult to track. A simple representation and easier algorithm to implement is to start with an ordered fan of rays emanating from a source and place points at uniform intervals based on time or distance along each ray. Wave fronts can then be simulated by connecting pairs of points in the same order as the rays (assuming the rays were generated in an ordered manner). Early implementation showed that adjacent pairs of rays must not be connected if they are reflected off different walls as was illustrated in Figure 1. The displayed wave fronts, see Figure 2a, are actually made up of short line segments (if the number of rays generated is large). The actual points used to generate the wave fronts were kept as an alternative display option.

Since all of the wave fronts are computed and stored before display, another option is to step through the wave fronts in a time sequence at a controlled rate thus producing an animation, see Figure 2b, of the waves propagating through space. Also, this version of animation not only shows sound pressure but also shows some aspect of particular interest.

Figure 2a: Variations for display of rays and waves: rays (upper left); rays (upper right); dots (lower left); composite rays and waves (lower right).

Figure 2b: Wave animation sequence.
All of the current modes of display, however, are derived from ray trace algorithms so the implicit limitation about neglect of diffraction at edges remains to be dealt with later. In conventional teaching about the propagation of sound, wave fronts are sometimes sketched for very simple cases but usually, when drawing by hand, only rays are actually constructed from images and they are laborious enough. Here, the computer quickly accomplishes any of the display modes and the animated wave front sweeping through the room seems to be the most natural representation with which to begin an investigation of that room. For the experienced acoustician, that takes a little getting used to because rays have been more familiar but primarily because drawing any other type of display was too laborious. Now, it appears to us that when sitting at a computer, the wave front animation mode will be the preferred one with the other display modes being available for particular situations. The clear superiority of an animated wave front display is difficult to demonstrate in this static printed paper.

Work in progress: current 2D implementation

As mentioned earlier, we have started this project by working on the development of a similar 3D program to gain insight into many of the operational and presentation problems before undertaking the full complexity of a 3D implementation. However, to the extent possible, the 2D program is organized with the goal in mind of extension into 3D. The 2D program has been and continues to be a rich learning experience. The current version is described below. It has evolved considerably from where we started. We have progressed to the point where we think a suitable 2D organization is beginning to emerge although there is still much to be done.

General features

This 2D application file, Acoustic.exe, is written in C++ using the Windows Application Programming Interface. The program development environment (IDE) is Watcom and the software relies on a set of geometry, scene and view classes developed by the authors. The program analyzes one 2D space at a time, usually a room plan or room section, and allows for control over surface absorptions, sound sources, sound receivers and mode of sound field display, i.e., rays, wave fronts, wave-animation, etc. Although the program is interactive, it depends upon three ASCII files: a wall network file, a library file containing acoustical surface absorption characteristics, and a library file containing acoustical sound source characteristics. An assembled acoustical project file is produced when the various acoustical choices are made and saved by the application program.

When this 2D program is loaded, it presents a window which lists four pull down menus at the top: File, Edit, Compute, Palettes. These four menus will be discussed in more detail further along but for now, the File menu deals with importing the geometric description of a room. Edit deals with the acoustical features which have to be incorporated with the geometrical description of the room to complete an acoustical problem definition. It includes the absorption characteristics to be assigned to the room surfaces, the identification, placement and acoustical characteristics of sound sources in the room and, if desired, the identification, placement and acoustical characteristics of receivers (listeners) within the room. The Compute menu instructs the program as to what it is supposed to present about the acoustical situation described by the choices made from the File and Edit menus while the Palettes menu handles operational aspects of displaying the acoustical output in the window.

Importing Room Geometry

When first calling this program, the user would normally use the File menu to import the geometrical description of the room in ques-
tion. At the moment, the points and connections are recognized using the extension *.nw2 and *.def as valid input. Figure 3 shows the program window ready to import a geometry file.

When such a file is selected, the program asks the user to declare whether the dimensions are English (feet) or Metric (meters) and to open the Sources.src and Walls.aum files to have them available to the application. Then, the outline of the room is displayed in the window. It has been automatically scaled to display as large as will conveniently fit within the window but the specific scaling for the window is of no consequence to program output. Figure 4 shows the window displaying a line drawing of the 2n geometry contained in the Classroom2.nw2 file. This room section will be used as the presentation example for the continuing discussion. The drawing in Figure 4 is visual proof that the imported geometry is what was intended, but a viable acoustical problem does not exist until the lines have been identified with wall con-

structions from the Walls.aum file and at least one sound source has been chosen from the Sources.src file.

conversion into acoustical problem

Next, the Edit menu is called and using the appropriate entries found there (see below), the wall, source and, possibly receiver characteristics, are selected to produce an acoustic file which then contains the geometry to the appropriate English or metric size and the initial selection of acoustical features which combine to define the acoustical problem. This completed information constitutes an *.aro file which can be run according to choices yet to be made from the Compute and Palettes menus. Once the initial acoustical choices have been made to produce the internal *.aro file, that file can be annotated for future reference and then saved by going back to the File menu. The advantage to saving a completed *.aro file is that in future working sessions, it can be called directly to load that room ready to be run again with the acoustical choices last made when it was saved. Of course, all acoustical choices can be altered from the menus as needed in the course of exploring the room acoustics by “running” various appropriate situations.

The operation of the 2n program will now be explained by means of a specific example, which started as Classroom2.nw2, and some of the options currently in the program will be mentioned. The example is a vertical longitudinal section through a possible small classroom with a teacher standing at the front of the room and speaking facing the class. There are five rows of student desks throughout the length of the room but the last two rows can be elevated on raised platforms. An extra line has been drawn just above the structural floor and under the seating area. This line can either be ignored or declared 100% absorbing to remove a possible floor reflection which would ordinarily be obstructed by the seating. An alternative for cre-
ating the same program control feature would be to break the floor line itself into two sections, one of which represents the floor under the seating. The method of an extra line seems a bit more convenient. A second source, a student in the third row facing forward toward the teacher has been chosen also. The floor is concrete, the two end walls are concrete block, the two ceiling planes are drywall and the platforms are plywood. The two sloping ceiling surfaces might occur in some one-story school designs. The platforms at the back of the room constitute an extra within the room enclosure and can be toggled ignore to examine the acoustics without this detail. There is no requirement for a room section to be so simple or so barren, it is just a convenience for presenting and discussing the program dialog boxes. Also, this room section is not claimed to represent an optimum design for a small classroom, merely one that is possible and that might be developed to have reasonably satisfactory acoustics for speech.

The File Dialog Box called from the File menu as shown in Figure 3, displays options of Open, Save, Save As, Import, Export, Plot and Exit. Open calls up a listing of *.aco files currently available to the program. If such a file had been saved previously, then it is simply called and that room will be loaded ready to be run, or altered and then run, by the program. Save and Save As allow new or updated *.aco files to be saved for future use. Import is used to bring in a new room geometry; it allows a further choice between *.aro and *.adj files. Export allows a further choice between *.aro and Receiver Data in the form of a *.txt file and a further choice between “replace” or “append.” The idea behind Export is to be able to store and move data generated by this program into other programs. For example, Receiver Data contains the numerical data for all of the receivers declared in the *.aco file if receivers has been checked in the compute menu and the program has been run. That data includes up to four reflections if the rays went through the receiver circles. (A more complete description of file content appears in Figure 11). Such a file can be exported into, for example, a spreadsheet program to support other types of analyses. By allowing “append,” one or more modified acoustical problems can be run and all of the results accumulated for export into some other program. The possibility to export as *.aro looks forward to when some modification of the room geometry will be implemented from the program window but for now, it simply extracts the geometry from an *.aco file in case the original *.aco file has been discarded. Plot is not currently implemented but anticipates producing hard copy directly from the acoustics program.

The Edit Dialog Box includes Source, Receiver, Walls, Source Library and Annotation as

---

![Figure 5: Wall Assembly dialog box called from the Edit menu.](image)
possible choices. Choosing Edit-Walls opens the Wall Assembly dialog box, Figure 5, which displays a small version of the room geometry as obtained from the imported *.mat file. All of the room lines on the screen are in blue except for the currently selected one which is red; it can be stepped around using the Next–Previous buttons. Opposite the word, Assembly, will be found the name of the wall construction currently assigned to that line from the Walls.aum file. At first pass, the user is expected to choose from the choices called in from the long box immediately below. As shown, the left hand wall, wall o, has been assigned as ConcreteBlock, and it is declared to be visible. The user would step through the lines and assign appropriate characteristics to each. If a previously completed *.aum file already existed, the previous choices would be displayed as the lines are stepped through but they can be changed at will to any of the other choices installed in the Walls.aum file or modified by the different options available in this dialog box.

The four check boxes provide temporary modification of how the lines will be treated in carrying out the next run of the program. Lines can be ignored, made invisible or made 100% absorbing. Also, all walls can be declared to have the same assigned absorption coefficient regardless of the more specific choices selected from the Walls.aum file. These several features, used alone or in combinations, can help the user to interpret how the sound is distributing about the room. A feature of the space, such as the platform at the back of the class room in the present example, can be ignored to see what the sound field is like without that feature present and without going outside the program to modify the geometry file, *.mat. As another instance, in a section through an auditorium, a possible balcony could be included in the geometry file and the sound fields compared with the balcony present and with the balcony ignored. Declaring a room surface 100% absorbing will temporarily stop reflection from that surface to assisting in understanding a complicated sound field. Each of the several dialog boxes also remind the user of whether the dimensions are in English or metric units. The user simply clicks OK to leave a dialog box and return to other menu choices.

When continuing to define the acoustic problem, the appropriate next choice would be Edit–Source. At least one source must be placed in a room in order to have a completed acoustical problem to examine; no source, no sound field. This Sound Sources dialog box, as shown in Figure 6, permits the user to delete, add (new) and step (next) through the chosen sources. A Source name can be assigned which will be appropriate to the application, such as Teacher or Student in the current example. Then the angular direction the source is pointed needs to be

![Figure 6: Sound Sources dialog box called for the Edit menu.](image)
entered; 0.00 degrees implies a source pointed along the positive X-direction and positive degrees increase in counterclockwise rotation. This choice is followed by the X- and Y-coordinates of the source location and a reminder of units to be used, English or metric, appears near the bottom of this dialog box. Then the Type of source must be selected from those currently available in the Sources.src file which can be scanned through in the box provided.

Choosing a source Type fills in the Cone angle and the Decibel level. (By convention, acoustical science uses metric units and this decibel value is the level produced one meter away on axis by the source. The underlying metric unit here is invisible to the user and has nothing to do with whether the room geometry was expressed in English or metric units; the program makes any necessary conversions in carrying out related calculations.) In the illustrated situation, the source Type is HumanVoice with a 140 degree Cone angle and a 60 Decibel source level. These values imply a limited forward angle of 140 degrees for projecting highly articulated speech and 60 dB is a textbook value for conversational speech; a value probably a bit low for the vocal effort of a teacher facing a small classroom full of students.

Neither the cone angle nor the source level values can be altered directly from the Sources dialog box but these values can be changed by calling Edit Source Library, going to the source type and changing the values. Such changes are temporary to the applications currently on screen unless the Sources src file is deliberately edited outside of the program and re-saved. In the present example, a second source, Student, was also declared for a student seated in the third row and facing toward the teacher, i.e., 30 degrees.

Running the sound distribution problem

At this stage, a viable acoustics problem exists for this classroom section comprised of a geometry, a set of wall characteristics and at least one appropriately located source. It can be run with appropriate choices from the Compute and Palettes menus. However, at this point, some appropriate annotations should be added and then the problem should be saved by going back through the File menu yielding a Classroom.wav file. Strictly speaking, the numerical values of absorption obtained from the Walls.wav file and the decibed source level are not used unless one or more Receivers has been entered from the Edit Receivers menu. At this point, only the directional distribution of the sound field can be calculated and displayed from the program. The cone angle of a source and the source direction completely determine where the direct sound is going. The lines representing the room, reflect the sound impinging on them in a mirror-like manner. Lines can be ignored or made 100% absorbing to stop a reflection but all computer runs address the question of where does the sound go as a consequence of source directivity and geometry of the enclosure.

Figures 7a and 7b display a sound animation frozen at two different intervals of time after a sound impulse uttered by the teacher. Only one reflection is called; that extra line just above the floor and the platforms have been ignored although they have been left visible; other choices from the three palettes are evident below the room section. In Figure 7a the direct sound has just reached the location of the student in the third row and the floor and ceiling reflections are sweeping along behind but have not yet reached that student. The floor continues to reflect the sound since that extra line has been ignored. The free end of both reflections is due to the limiting cone angle assigned to the source. This geometric limitation is not quite realistic but we have not yet implemented any fix-up for diffraction or finite wavelength phenomena.

In the case of Figure 7b, the direct wave has just reflected from the back wall, the floor reflection is sweeping upward with its lower end touching the back wall. The reflection from the
front portion of the ceiling is approaching the rear wall and the reflection from the rear portion of the ceiling is sweeping downward at a rather steep angle. Since only one reflection was enabled from the surfaces, a reflection ends when it encounters another wall. Thus, the floor reflection does not reflect again when it reaches the ceiling surfaces. At least two reflections would have to be enabled for a floor then ceiling reflection to be displayed. Also, the fact that the platform has been ignored is clearly evident.

Figures 8a and 8b illustrate versions of the classroom acoustical problem displayed in the ray trace mode. In these cases, the insert line just above the floor is no longer ignored and it was declared 100% absorbing to block reflection from the obscured portion of the floor. The platform is no longer ignored and reverts to the absorption characteristics of plywood which make it reflective. Also, to avoid excessively cluttering the display, both end walls have been temporarily assigned 100% absorption. Again, only one reflection is called and only 35 rays assigned for this particular display. The same Human Voice source type produces quite different ray patterns from the two locations.

When the user has imported the *.n2x file and made choices from the Wall Assembly and Sound Sources dialog boxes, an acoustical problem has been produced for the room geometry. This defined problem can be run and the corresponding sound field displayed on screen as rays, dots, waves or animated by entering appro-
ropriate choices from the Compute and Palettes menus. The minimal acoustical problem described to this point only deals with the question of where does the sound go in view of the room geometry, source location and source directional characteristics. Since specific receiver (or listener) locations have not yet been defined, neither specific times of arrival at a receiver nor the intensity of the arriving sound can be calculated. However, the Edit Receiver call on the menus permits one or more receivers to be named and their locations to be defined. This new information can then be added to the *.ao file if a save is made otherwise the receiver information will just reside in the operating file temporarily. In either event, the choices can be altered or deleted whenever the user wishes.

**extending problem to include receivers**

Continuing with the classroom example, five receivers have been entered at the locations of the anticipated five rows of students. A receiver is identified by a name which makes sense in terms of the problem, i.e., Rows, and the X, Y coordinates of its location and a value of radius. The receiver in the computer program is actually a circle of stated radius centered as specified. Then when a program run is carried out, if a reflected ray intercepts a receiver circle, it is counted as reaching the receiver and the time delay involved will be calculated in milliseconds and the sound intensity arriving by way of that path will be calculated in decibels. If the rays are too far apart and the radius too small, a reflection may miss and not be identified. Thus, to carry out quantitative calculations, it is important to choose a fairly large number of rays and choose a receiver radius that is as large as will provide an acceptable resolution. In situations similar to the classroom example, a radius of one foot (or 0.3 meter) seems about right. Obviously, that circle is larger than a human head but if the intended listener is allowed to move around a bit, a one-foot radius is a reasonable value to account for where that head is apt to be found.

The program draws the five receivers as circles (green on the computer display) at the appropriate locations, as shown in Figure 9. Visually, the receiver circles are a useful in mentally picturing the situation and receivers, once defined, can be ignored if so desired. In the example, only the Rows 1 and Rows 5 are wanted for quantitative analysis so the other three are ignored. The figure shows a wave-animation at 8.85 milliseconds delay. The direct sound wave has passed the Rows student and almost passed the Rows student. The other three have not heard anything yet but the Rows student is just now receiving a reflection from the front part of the floor and the ceiling reflection has not yet gotten down to any of the receivers.

If the Edit Receivers menu is opened after running the program, one will find more detailed information about what took place at the selected receiver locations. Figure 10 shows such results. Now the Results portion of this dialog box has numerical data filled in about the time of arrival and the decibel level of the first direct sound to arrive and the time of arrival and level of the first reflected sound to arrive. Immediately below, for convenience, occur the time delay difference and the decibel level difference for the first direct and first reflected sound. Since only one source was activated, the source was the teacher in both cases but that need not always be the case. In the upper middle of the Receiver s/Rows dialog box occurs a
circle with two radial lines. One of the radial lines shows the direct sound from the standing teacher arriving with a small downward angle and the other line shows the first reflection from the floor coming upward at about 45 degrees. In the lower right of the box, a small reflectogram plot appears. Decibel level is plotted vertically and time horizontally. The first two lines represent the direct sound and the first reflected sound in this case and will agree with the numerical data found to the left. The internal program has been set to include reflections up through fourth order and so several later and weaker arrivals are plotted also. On a color monitor screen, the lines for the direct ray are red and for the reflected rays, blue.

In the case of Receiver 3/Rows 5, appropriate values are found for the direct and first reflected sound. Now, the directional circle shows that the direct sound arrives from essentially straight ahead (remember the student’s desk here is elevated on a platform) and the first reflection to arrive comes from the wall behind the student. The reflectogram indicates many more reflections arriving only slightly delayed while from the previous example of Receiver 1, there was quite a gap in time before the arrival of more reflections. However, it is necessary to be cautious about interpreting too much about the sound field from these reflectograms. They are accurate for the 3D section under investigation but a similar investigation of the corresponding 2D plan would show different results and neither currently take skew rays into account. Thus these reflectograms tend to look forward to one possible way of presenting results from a full 3D implementation. In the present 2D version, they have been most useful in checking that the indicated time delays and levels are accurate when multiple reflections occur.

exporting receiver data

Another feature is available when Sound Receivers has been activated. The data about all of the reflected rays up through the internally set fourth order is computed and held in internal memory before the screen display is created following a run command. It is that internal memory which holds the data used to produce the little reflectogram plots seen in subsequent callings of the Sound Receiver dialog box. This same data can be exported as a simple ASCII *.txt file by calling File->Export->Receiver Data. Figure 11 shows an example of such exported data from Rows 5 of the acoustic problem contained in the Classroom_3.00 file.

The exported *.txt file contains the name assigned to the receiver location, whether the
ability to export data should be particularly useful when a fully 3D version of our program has been completed. It will permit a completed investigation of a first phase acoustical design to be carried forward into other types of acoustical investigations if so desired.

summary of 2D version

The functioning of an interim two-dimensional version has been described by means of an example. The essential idea is to address the acoustical consequences of a preliminary architectural design at the earliest possible stage with a simplicity and convenience that will encourage such investigation by students. The software attempts to address, in a preliminary way, the question of where does the sound go as a consequence of a preliminary design of a space. Then, assuming the distribution of sound is somewhat reasonable for the intended use of the space, questions can be extended to ask what time delays, decibel levels and directions of arrivals occur at representative listening locations for the direct sound and a few of the first reflections. Such information, when combined with a student’s background studies about desirable listening conditions, will help a student to develop designs in acoustically viable directions. There is no intention to include the many sophisticated acoustical considerations and fine-tunings that are thought to be necessary to develop a design for a superb concert hall. The intention remains to address the first consequences of a spatial design and to assist a student’s early learning processes.

The 2D work-in-progress version has served as a learning experience to explore various ideas for inclusion into the program and how they interact with one another. As it now stands, this version appears to be very useful in its own right. It permits creating useful early teaching diagrams of acoustical situations, i.e., examples of omnidirectional/unidirectional sources, inverse square law, directional reflection of sound from a surface, sound represented by
Architectural Acoustic Teaching Software

waves, rays and temporal animation, etc. A wider variety of situations can easily be drawn than would normally be done at the blackboard or in study notes. The same ease of drawing can be carried out in a greater variety of room sections and plans, chosen to illustrate particularly important acoustical consequences. Related homework problems can be posed, with increasing complexity, that would have been too tedious and time consuming previously. Presumably, a students’ own designs can be investigated with similar ease either by students working at their own convenience or in a one-on-one setting with a teacher. However, the students’ own design applications remains to be tried out in actual practice at this writing; probably some pilot applications will be undertaken during the upcoming fall semester. In spite of the limitation to 2D in the first implementation, the program seems capable, in its present form, of assisting the teaching of architectural acoustics by accomplishing a dramatic reduction in the drudgery of drawing the representations and by including wave front animation. The situation of teaching primarily with 2D representations while trying to get the students to think three-dimensionally has not been significantly altered but the ease of generating 3D representations has been much improved and temporal wave front animation has been made available. Figure 12, a ray trace display, will suggest why some assistance is needed to comprehend the acoustics of a relatively simple design.

Future directions

The work to date seems to be progressing at a reasonable rate, however, much remains to be done to even begin to approach the ambitious goals outlined.

DXF importing

Initial exploration is currently underway in this direction. The 3D application will allow interactive (sketching) editing of the enclosure network and allow importing of DXF Arcs. Since there are many good 3D solid and surface modelers available which can export geometries in DXF format, the 3D application will allow for the import of enclosing room surfaces. Then, that geometry can be extended into a 3D acoustical program by editing with appropriate versions of wall, source and receiver dialog boxes similar to current 2D implementation.

Display of 3D representations

Since the simultaneous display of 3D space enclosures, sound sources, receivers, rays, wave fronts, and animated wave fronts is a researchable topic by itself, the authors intend to experiment with existing 3D graphics programming environments such as OpenGL. Although the animation of wave fronts was obvious in 2D, it is not yet clear how similar animation can be displayed effectively in 3D.

Interactive modification of wall, source
and receiver locations

Future versions of the application will allow interactive translation of wall points as well as
sound-source and receiver locations and modification of source orientations. This is expected to be in the form of cursor positioning and dragging as is done in most commercial 2D sketching applications.

**Frequency issues**

Audible sound generally is said to span a frequency range from 20 Hz to 20,000 Hz, some ten octaves, and even traditional architectural acoustic considerations span six octaves (25 Hz–4000 Hz) in the middle of the audible range. About the only acoustic parameter which is even approximately constant over such a wide range is the velocity of sound. The acoustical characteristics of sources, receivers, constructional types, importance of architectural details, etc., vary considerably across frequency. Consequently, even introductory pedagogy in acoustics must, at some stage, deal with frequency related issues in a fairly realistic manner.

We have been aware of such issues from the outset and they have appeared in our current work in slight degree, e.g., the cone angle of sources and the organization of wall construction files. We have not yet settled on how to handle the frequency issue at a level of detail commensurate with an emphasis on the early architectural design phase; perhaps just low, medium and high frequency choices, perhaps octave bands. Issues of source directionality can become very complicated and the issue of how to cause the graphics to gloss over architectural details as they become small compared to the wave-length of sound in air involves difficult diffraction and scattering considerations.

Originally, we felt that we would have to face the diffraction problem rather early in the development process and find a satisfactory way to soften the boundaries of fans of rays, shadow regions, directional sources, etc. We still intend to accomplish that, however, our current experience with 2D suggests that for an early design investigation, if those sharp boundaries had not already existed, we would have had to invent them as a means for dramatically presenting the preliminary acoustical aspects.

In the current 2D version, point sound sources radiate the same sound level regardless of direction within a specified cone angle; that is not a very accurate representation of the source strength, directivity and frequency variation of real sources. In the case of the human voice, vocal effort varies with the situation and speech intelligibility varies with direction about the head in a manner not easily represented by simple fixed source characteristics. Other important types of sources can be large and spread out in space, e.g., an orchestra, a church choir or a large pipe organ.

A human listener has been implicit as the receiver in most current work but a more complete characterization may be needed; frequency and directional response variations occur for the receiver also, not to mention how the time delays for several arrivals of a sound are perceived and subjective responses such as loudness. The directional symbol and the reflectogram shown earlier in Figure 10, for example, are just a slight nod toward dealing with directional perceptions of sound which can be important for both speech and music.

Compact seating arrangements, as in churches or theaters, raise issues of variation of listening conditions throughout an entire seating area. Concentrated seating areas affect the sound fields which develop in a room because of absorption and scattering. Sounds propagating closely above the heads of an audience area, are attenuated significantly more with distance than when propagating higher up. It may be desirable to find a means for also displaying the acoustical characteristics for a large block of seats rather than at one or a few isolated receiver locations.

170
other acoustical analyses and assistance

So far, acoustical criteria have not been entered explicitly into the program and it is probably undesirable to go very far in that direction. Students have a tendency to unwarily accept criteria buried within computer programs and allow such features to substitute for thoughtful, knowledgeable interpretation. However, some simple choices in the form of a preselected level, level variation across the seating, range of time delays, etc., could be called as options and perhaps displayed as color changes or iso-value contours on the graphics.

Especially, when a 3D geometry can be imported and augmented by wall construction type choices, the areas of surface materials and the enclosed volume will almost automatically become available in the process of generating an acoustical problem from the geometry. That form of acoustical information is the necessary input into some other types of acoustical calculation programs such as for average absorption coefficient, reverberation times, critical distances, consonant articulation loss, etc. That type of acoustical information is also exactly that which is so tedious to work out by hand from the usual architectural plans, elevations and sections. Then the ability to export files, suitably extended beyond exporting receiver data now demonstrated in 20, should be able to serve far more than the primary goal of graphically displaying the direct and first reflected sound waves propagating throughout a tentative room design.

Any teaching software must provide, for each action taken, explanations of concepts, formulas, algorithms and definitions. These are in addition to the usual help feature for providing assistance in operating the software. Such aspects will have to wait until most of the technical and display features discussed above have been rounded into shape.

conclusion

By selectively and intelligently applying the techniques presented in the current two-dimensional application, it is possible to investigate the acoustical consequences of any initial design. If that initial design is found wanting in some acoustical particulars, modifications which the student architect is willing to consider can be tried to see if and how improvements can be accomplished. This program does not attempt to provide for the fine tuning that an acoustical expert may be able to achieve with or without computer support. Rather, it aims at enlightening the student about the first acoustical implications of a preliminary design. If the computer program can be kept sufficiently friendly and useful when expanded to 3D, the student will probably want to carry it along while advancing into the role of a practicing professional architect after graduation. Then, the program may be found to be useful for professional application even though the initial intent has been primarily pedagogical.